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Introduction 
  

In this lab you will assemble and test your utility board containing an Altera Cyclone III 

FPGA, a PIC microcontroller, a configuration PROM, LEDs, switches, a clock oscillator, 

and a D/A converter for VGA output.  You will be using the board for the remainder of 

the semester, so it is very important to assemble it properly. But don‟t worry! If you 

damage parts on your board, you may obtain parts for another one from the stock room. 

 

Objectives 
 

 Learn how to solder 

 Assemble your utility board 

 Write a Verilog module to control LEDs and a 7-segment display 

 Program the FPGA with your Verilog code 

 Test and debug the utility board 

 Interface the 7-segment display to the utility board 

 

Requirements 
  

Follow the steps in this guide to become familiar with and assemble your board. Write 

some Verilog code to exercise the FPGA using the switches, LEDs, and a 7-segment 

display to ensure your board is operational.  Simulate and synthesize your code, then burn 

it onto the Flash memory and test the board.  Hook up a 7-segment display and 

demonstrate that it works. 

 

Background 
  

In the 1980‟s and 1990‟s, digital design projects were built from a truckload of chips, 

each containing a few logic gates such as 74xx series logic gates or simple programmable 

array logic chips (PALs).  Such projects involve placing and wiring together dozens of 

chips on a breadboard.  It was easy to make a wiring mistake or burn out a chip and spend 

hours tracking down the problem.  Now you can perform all of your digital logic on a 

single field-programmable gate array (FPGA) to greatly reduce the necessary wiring and 

number of chips. Later in the course, you will use a PIC microcontroller to write 

programs in assembly language and C that can interface with external hardware and the 

FPGA. 
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You will need to connect your FPGA to the real world to get inputs and outputs.  In 

particular, you will often find it useful to have a clock oscillator, switches, and LEDs.  

Moreover, the FPGA comes in a 144-pin thin quad flatpack (TQFP) package.  This is a 

surface mount (SMT) part so the pins of the chip do not go through the printed circuit 

board (as with many of the other through-hole parts you‟ll be working with).  SMT 

components are mounted on pads on top of the PCB.  Their pins are so small that special 

soldering skills and tools are needed to reliably attach them to the board.  Your board 

comes with the FPGA and its Flash memory already attached, but you will get to solder 

the rest, including a few easier SMT components.   

 

The FPGA you will use in this course is the Altera Cyclone EP3C5, which contains 5136 

Logic Elements.  The microcontroller is a Microchip PIC32MX675F512H with 64 KB of 

RAM and 512 KB of Flash program memory and many I/O ports. You can find the 

databook for these in the lab notebook and on the class web page.  You will need to 

become familiar with the internals as you progress in this class.  

 

The board was designed to maximize your access to the capabilities of the FPGA and PIC 

from a breadboard. Therefore, as you will notice, the board has a single row of 58 header 

pins  (on one of the long sides of the board) that give you access to most of the FPGA 

pins and all of the PIC I/O pins (except for reserved programming pins).  The other pins 

in the FPGA are power, ground or unused. Furthermore, the pins are labeled for your 

convenience. If interested, we advise you to look at the Cyclone III and PIC databook. It 

contains full explanation of the functions of each pin. The other characteristics of the 

utility board will be explained later, in the Discussion section of this guide. 

  

Figure 1 shows the schematic for the utility board. It is advisable that you study this 

schematic to understand what goes on in the board because you will need this information 

to use and debug your board and are likely to be asked about some subsystem during your 

checkoff. The parts in the schematics are labeled using R for resistors, C for capacitors, 

and U for units (chips and other large parts). 

 

Discussion 
  

Figure 1 shows a schematic of the utility board.  Major components include the power 

supply, header pins, clock generator, DIP switches, reset pushbuttons, USB ports and 

selector switch, VGA connections, the debugger/programmer connectors, and LEDs.  

 

Read through and understand this section that describes each of the board components.  

Identify the components in the schematic and think about how it operates.  The 

subsequent section will guide you through the assembly process. 
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Figure 1 – Utility Board Schematics  
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Table 1 lists the bill of materials (BOM) with more information about each of the components on the schematic.  
 

 
Mudd32 Bill of Materials 

       
Last updated 17 August 2011 David_Harris@Hmc.edu 

      
Component 

Description Manufacturer Mfr Part # Supplier Sup Part # Quant 
Unit 
Price 

Total 
Cost 

 
PCB Advanced Circuits P75294 

  
1 $15.18 $15.18 

U10 
PIC Microchip PIC32MX675F512H Digikey 

PIC32MX675F512H-
80I/PT-ND 1 $7.14 $7.14 

U9 Cyclone III FPGA Altera EP3C5E144C8 Digikey 544-2431-ND 1 $12.80 $12.80 
EPCS4 FPGA flash Altera EPCS4 Digikey 544-1243-5-ND 1 $13.00 $13.00 
U3 40 MHz clock oscillator Epson SG636PCE  40 MHz Digikey SE2851CT-ND 1 $4.38 $4.38 
U2 Quad DIP switch Grayhill 76SB04 Digikey GH7170-ND 1 $0.92 $0.92 
FPGA/PIC_RESET SPST pushbutton switch Panasonic EVQ-PAE04M Digikey P8008S-ND 2 $0.29 $0.58 
L111712 1.2V low-dropout regulator ST LD117DT12TRI Digikey 497-1231-1-ND 1 $1.16 $1.16 
L111725 2.5V low-dropout regulator ST LD117DT25CTR Digikey 497-1233-1-ND 1 $1.16 $1.16 
L111733 3.3V low-dropout regulator ST LD117DT33CTR Digikey 497-1235-1-ND 1 $1.16 $1.16 
U18 10-segment LED array Lumex SSA-LXB10IW-GF/LP Digikey 67-1010-ND 1 $2.85 $2.85 
U14, U17 330 ohm resistor network Bournes 4610X-2-331LF Digikey 4610X-2-331LF-ND 2 $0.29 $0.57 
R1-4, R11, R16 1K resistor Yageo CFR-25JB-1K0 Digikey 1.0KQBK-ND 5 $0.01 $0.05 
R5-8, R14-15 10K resistor Yageo CFR-25JB-10K Digikey 10KQBK-ND 7 $0.01 $0.07 
R9 510 ohm resistor Yageo CFR-25JB-510R Digikey 510QBK-ND 1 $0.07 $0.07 
R10, R12-13 75 ohm resistor Panasonic ERD-S2TJ750V Digikey P75BACT-ND 3 $0.05 $0.15 
U8 VGA DAC Analog Devices ADV7125 Digikey ADV7125KSTZ50-ND 1 $6.30 $6.30 
C2, C4-5, C7-9, 
C13-14, C16-18 0.1 uF capacitor Panasonic ECQ-V1H104JL Digikey P4525-ND 11 $0.08 $0.90 
C1, C3, C15 0.01 uF capacitor Panasonic ECQ-V1H103JL Digikey P4513-ND 3 $0.08 $0.25 
C10-12, C19 10 uF capacitor Panasonic ECA-1CM100 Digikey P5134-ND 4 $0.05 $0.20 
C6 10 uF tantalum capacitor AVX TAP106K025SCS Digikey 478-1841-ND 1 $0.63 $0.63 
U4 USB jack A EDAC 690-004-621-013 Digikey 151-1080-ND 1 $1.10 $1.10 
U11 USB jack B EDAC 690-004-221-023 Digikey 151-1121-ND 1 $0.83 $0.83 
U1 36-pin header 3M 929400-01-36-RK Digikey 929400E-01-36-ND 2 $1.32 $2.65 
U12 ICD connector Tyco 5520250-3 Digikey A31406-ND 1 $0.61 $0.61 
U20 VGA connector Tyco 1-1734530-1 Digikey A35116-ND 1 $1.63 $1.63 
U19 FPGA download connector Tyco 5103309-1 Digikey A33160-ND 1 $0.76 $0.76 
U16 2x8-pin female header Sullins PPPC082LFBN-RC Digikey S7111-ND 1 $1.30 $1.30 
U13 10k trimpot Copal CT6EW103 Digikey CT6EW103-ND 1 $0.26 $0.26 
S1 SPDT microswitch Tyco SLS121PC04 Digikey 450-1598-ND 1 $0.91 $0.91 
Total: 

       
$79.57 

Table 1 – Bill of Materials 
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Power Supply 

 

The utility board is supplied power by the header pins Vin and GND.  The input supply 

should be at least 5 volts; for example, an unregulated 9 V DC transformer suffices.  It is 

regulated down to 3.3 V, 2.5 V, and 1.2 V to serve various components on the board.  

The 3.3 V regulated voltage is also available at another header pin to serve other 

components you might want to connect to your board.  

 

In the lab, the easiest way to supply power is from a benchtop power supply to the Vin 

header pin.  If you do not have a power supply available, a DC transformer is an 

inexpensive alternative.  For unteathered applications such as robotics, you can also use a 

battery pack providing at least 5 V.  

 

The PIC and FPGA I/O‟s will operate at 3.3 V, which we will call VCC.  The FPGA 

contains tiny logic transistors that would burn out at 3.3 V, so the 1.2 and 2.5 V supplies 

are needed to operate the digital logic and the analog circuitry within the FPGA.   

 

Header Pins 

 

The board provides one 58-pin row of male header pins that tap out signals from the 

FPGA and PIC, LEDs, switches, and power and ground. The header pins will be installed 

along the left side of the utility board. 

 

Clock Generation 

 

In digital electronics, the term clock refers to a square wave that oscillates between GND 

and VCC.  Typically, clocks are used to sequence the action of a circuit. For instance, a 

flip-flop samples its input every time the controlling clock rises from logic 0 to logic 1.  

The clock signal is also sent to the PIC and the FPGA.  The utility board provides 40 

MHz clock from a crystal oscillator. 

  

DIP Switches 

 

The DIP switches provide a convenient source of inputs to circuits in your FPGA.  When 

the switch is closed, it delivers a high output.  When the switch is open, a pull-down 

resistor produces a low output. 

 

Reset Pushbuttons 

 

There are two reset pushbutton switches on the board.  The pushbutton near the PIC 

resets the PIC, and the one near the FPGA resets the FPGA.  Upon reset, the PIC will 

simply restart its program and begin as if it has just powered up.  The FPGA, however, 

will have its memory cleared.  If the PROM is programmed, the FPGA will immediately 

reprogram itself from the PROM.  You will notice that these pushbuttons actually have 4 

pins. However, only two pins are used, while the other two are left unconnected (and 

simply provide mechanical stability). 
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Debugger/Programmer Jacks 

 

There are two programming connections at the top of the board.  The double row of 

header pins (marked JTAG) are for programming the FPGA.  The 6 pin jack (which 

resembles a telephone jack) is for programming the PIC microcontroller via the In Circuit 

Debugger (ICD 3) dongle.  You will program and debug your PIC in Lab 4. 

  

LED array 

 

There is a 10 segment red light-emitting diode (LED) array on the board.  The „ON‟ LED 

(far left LED, with the pin header towards you) simply tells that the board is powered ON 

and receiving 3.3 V.  The LED immediately to the right of the ON LED is unused.  The 

other 8 red LEDs can be driven by the FPGA or PIC.  Notice that there are 8 header pins 

labeled LED0 – LED7. These can be used in case you want the outputs of the LEDs for 

an external device. If a voltage is applied at one of the LED pins, the corresponding light 

is off for ground (GND) and on for voltage 3.3V (Vcc). 

 

There are a few concerns that must be addressed whenever using LEDs.  One is that 

LEDs glow nicely when given about 5 mA of current but may burn out when given more 

than roughly 20 mA.  Therefore, it is important to include a current-limiting resistor to 

prevent LEDs from burning out.  A 330  resistor does the job nicely, allowing  
    

    
= 

10 mA of current to flow.  (In actuality, the current is about half of this. There is a 

voltage drop across the diode (about 1.7V for red), which makes the actual current 
         

    
      . This is still around the desired 5-20 mA range and so still works). 

 

FPGA 

 

The FPGA contains a large array of configurable logic blocks (CLBs) and programmable 

interconnections.  The configuration information is stored in static random-access 

memory (SRAM) within the FPGA.  Therefore, the information is lost when power is 

removed and the device must be reconfigured each time it is powered up. 

 

The FPGA can be configured via the Programmable Read Only Memory (PROM) on 

board. On powerup, the FPGA will serially configure itself from the PROM if the PROM 

has been programmed.  It will also reprogram itself from the PROM when you push the 

reset button.  Alternatively, designs can be programmed directly onto the FPGA in the 

Quartus software via the JTAG connection.  This will overwrite the design already loaded 

from the PROM, but will only last until the FPGA is reset or the power is disconnected. 

 

VGA Output 

 

A digital-to-analog converter (DAC) is connected to dedicated pins on the FPGA and 

used to drive the VGA output on the board for control of a computer monitor.  The DAC 

has three 8-bit channels, one each for the red, green and blue signals.  75-ohm 

termnination resistors are used to prevent reflections in the transmission line (VGA 

cable). 
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Assembling the Board  
 

This section of the lab guide will give you tips on how to assemble the utility board. 

Following these tips will help you complete this lab quickly and in a logical way that 

places the flattest components first to make soldering easier. 

 

 Identify the Component Side of the Utility Board 

 

The utility board has two sides.  The component side, with the white silk screen markings 

indicating component placement, should go up.  All components except the 58-pin header 

are placed on the component side.  The parts (except the 58-pin header) are soldered on 

the reverse solder side. 

 

Using a multimeter, check that there is nearly infinite resistance between the pins labeled 

Vin and GND on the board.  If the resistance is low, you have a short circuit on your bare 

board and should get a new one.  As you assemble your board, occasionally check the 

resistance between power and ground.  If it is ever less than 10 , you‟ve introduced a 

short and should debug it before continuing. 

 

The PIC, FPGA, VGA DAC and PROM should already be soldered to your board.  These 

are fine-pitch SMT components that require practice to attach without creating solder 

bridges between pins.  If your board malfunctions and you suspect a bridged or bad 

connection on one of the SMT chips, check the connections under a microscope. 

 

CMOS components such as the FPGA are sensitive to static electricity.  Before you touch 

your board or solder anything, discharge your body by touching a large metal object. This 

is good practice when handling electronic components in any lab. 

 

When you begin soldering, moisten the sponge.  When the iron first heats up, tin the tip 

by applying a generous amount of solder all over the tip, then wiping off the excess on 

the sponge.  Periodically repeat as you work to keep the tip looking silvery rather than 

black and blistered.  When you make a connection, touch the tip of the iron to the pad on 

the board at the same time it touches the lead of the component.  Apply the solder to the 

joint, not the tip of the iron.  The solder should smoothly adhere to both the pad and the 

component pin rather than balling up on the component.  The connection should appear 

shiny; a gray color indicates a possible unreliable “cold solder” joint.  If you are in doubt 

about the quality of your solder joints, ask early on rather than doing all of them first and 

discovering that your connections are intermittent or unreliable.  Some of the components 

will be soldered close to vias (the small holes through the board used to connect between 

wiring layers on the printed circuit board).  Be sure excess solder does not bridge to the 

via, creating a short circuit.  When you are done, tin the iron one last time to protect the 

tip before turning it off. 

 

You may wish to use safety goggles while soldering, especially if you don‟t wear glasses.  

Also, be sure to hold the ends of leads as you cut them after soldering so they don‟t fly 
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into the eye of the person working across the room.  Solder contains lead, so wash your 

hands afterward. 

  

 Insert the Blue Wires  

 

Rev B of the board accidentally let out the wires connecting the DIP switches to the 

header pins.  Such PCB mistakes are traditionally corrected with thin (e.g. 30 gauge) blue 

wires joining the missing pins. Hence, the fixes have become known as “blue wires.” 

 

Before anything else, you will need to cut and insert four short thin wires to correct this 

error.  Cut the wires about 1.5” long and carefully strip ¼” of insulation off each end.  

Place them on the back side of the board to connect the botom of resistors R1-R4 with the 

header pins labeled SW1-SW4, respectively.  Bend the ends to hold them in place, but do 

not solder yet.  When you insert the resistors and header pins, place them in the same 

holes and solder both the component and blue wire to obtain the missing link. 

 

 Insert the Resistors and Resistor Networks  

 

The first components to install in the utility board should be the resistors. They will sit 

flat on the board. The polarity of the resistors does not matter, i.e., you can insert them 

whichever way you‟d like. However, it is good practice to install neighboring resistors in 

the same direction, making it easy to read them. See Table 1 for resistor part values. 

 

Next you should install the (isolated) resistor networks.  „Isolated‟ means that it contains 

a set of totally independent resistors.  These particular resistor networks are sets of 5 330 

 resistors and are installed at U14 and U17.  Pins 1 & 2 are one resistor, pins 3 & 4 are 

another, and so on.  Polarity does not matter.  You may find it helpful to bend one pin at 

each end of the resistor network to hold it in place while soldering. 


Part Reference Designations 

1k Ω resistor R1-4, R11, R16 

10k Ω resistor R5-8, R14-15 

75 Ω resistor R10, R12-13 

510 Ω resistor R9 

Table 1:  Resistor component values. 


 Insert the Voltage Regulators and Oscillator 

 

The next step is to insert the voltage regulators and oscillator. These parts are surface 

mount (SMT) parts.  Soldering a surface mount device would be easiest if you had three 

hands: one to hold the part with pliers, a second to hold the soldering iron, and a third to 

apply the solder.  One solution is to get a friend to hold the part, taking care not to apply 

the soldering iron to the friend.  Another is to apply a blob of solder to one of the pads on 

the printed circuit board before the part is placed.  Then place the part with the pliers and 

use the soldering iron to melt the blob onto the pin to hold the part in place.  Solder the 

remaining pins to their pads.  Then apply more solder to the first pin to be sure a good 
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joint is formed (a gray grainy appearance indicates an unreliable cold solder joint, while a 

silvery appearance covering the pad and pin usually means a good connection). 

 

The oscillator is a 4-pin chip, and its location is near the PIC. This location is marked 

with U3.  Be sure to align the notch on the board with the notch on the silkscreen.  Solder 

the surface mount parts from the top of the board.  Be sure not to fill neighboring vias. 

 

Next add the voltage regulators.  Be sure to put each voltage regulator in the correct 

location.  If you do not, your board will not work and you may burn out the FPGA. The 

large pad on one end of the voltage regulator requires a substantial amount of heat to 

warm up, so you will need to apply the soldering iron for longer than usual.  Be sure that 

you form a good solder joint between the large pad and the tab on the regulator; it is a 

common place for poor connections. 

 Install the Pushbutton Switches  

 

There are two small pushbutton switches that come with your kit, which will be installed 

at PIC_RESET and FPGA_RESET.  When installing one of these, you will have to align 

it in its holes and push until it snaps into location.  Do not put your finger directly 

underneath the board because the sudden popping into position could stab your finger.  A 

thin pair of pliers helps push the legs through.  The switch will only align in two positions 

on the board; either alignment will work. 

 

 Insert the DIP Switches and LED array 

 

The DIP switches are to be placed at the bottom of the board at U2. Align the writing on 

the DIP switches with the silk screen writing on the board. 

 

Insert the LED Array at U18.  Align the notch on the part with the square solder pad on 

the board for correct alignment. 

 

 Install the LCD Header and Trimpot 

 

Now install the trimmer potentiometer (trimpot) directly at U13, near the voltage 

regulators.  This allows adjustment of the LCD contrast.  You may need to bend the pins 

slightly with a pair of needle-nose pliers so that they match the holes on the board.  Install 

the 8x2-pin female header at U16, right next to the trimpot.   

 

 Install the VGA connector 

 

The VGA connector has pins connected to the 3-channel DAC, to provide analog red, 

green and blue levels, and to the FPGA to provide synchronization signals.  You will use 

the VGA connector in lab 7.  Install it at U20.  You may need to bend the outer rows of 

pins by a few mm in towards the center row before they allign with the holes.  Look from 

the bottom of the board to make sure all the pins are in their proper locations before 

pushing the connector on to the board. 

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 Add the USB ports and mode switch 

 

The PIC contains a USB module that can act in either host or device mode.  Install the 

USB ports near the ICD connector.  Each port fits in only one place.  Solder the smaller 

electrical pins and the large board-lock connectors. 

 

Install the SPDT slide switch by the USB ports.  This switch selects between the host and 

device ports by either powering the VBUS signal from the board (host mode) or letting 

the PIC sense when the VBUS signal has been powered from another source (device 

mode). 








 Insert the Bypass Capacitors 

 

The voltage regulators supply current sufficient to meet the average demand of the 

circuits on the board.  However, they cannot respond quickly enough to deliver spikes of 

current at high frequency, such spikes would cause the voltage to briefly droop. Instead, 

this current is drawn from bypass capacitors on the board, keeping the voltage at the 

desired level.  A typical digital system uses several sizes of bypass capacitors.  Larger 

capacitors store more charge and can deliver more current, but react more slowly.  

Smaller capacitors can rapidly deliver charge to handle short spikes of demand.  Overall, 

the bypass capacitors reduce the noise on the voltage supplies.  Note that the chips and 

board have some inherent capacitance as well, so the voltage might be stable enough 

even without bypass capacitors.  However, noise-related problems are so difficult to 

reproduce and fix that it is always better practice to put a generous number of 

inexpensive bypass capacitors on the board than to skimp on bypassing and hope the 

board works anyway. 

 

There are three 0.01 µF capacitors, eleven 0.1 µF capacitors, and four 10 µF capacitors to 

install.  Install the 0.01 µF caps in C1, C3 and C15, and the 0.1 µF caps in C2, C4, C5, 

C7, C8, C9, C13, C14, C16, C17 and C18 (polarity does not matter).  Next, install the 10 

µF electrolytics in C10, C11, C12 and C19 (polarity DOES matter).  There are two ways 

to determine polarity on an electrolytic capacitor.  If it is new and uncut, the longer of the 

two leads is the positive terminal (+) and goes in the + hole on the utility board.  The 

other way is to look at the capacitor and find the stripe going down one side.  This points 

to the negative (-) lead.  If you install an electrolytic with the incorrect polarity, it can 

leak or explode.  Now install the 10 µF tantalum cap at C6 (polarity DOES matter).  The 

polarity marker is missing from the silkscreen: put the positive terminal in the hole 

further from the header pins.  Small capacitors are often labeled with an three-digit code 

similar to resistors.  For example, 223 indicates 22•10
3
 pF = 0.022 F. See Table 2 for 

capacitor part values. 


Part Reference Designations 

0.01 µF capacitor C1, C3, C15 
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0.1 µF capacitor C2, C4-5, C7-9, C13-14, C16-18 

10 µF electrolytic cap. C10-12, C19 

10 µF tantalum cap. C6 

Table 2: Capacitor component values. 


 Install the ICD and JTAG connectors 

 

Install the JTAG connector at U19.  The connector is symmetrical, so rotation does not 

matter. The ICD connector looks like a telephone or Ethernet jack, and is installed at U12 

next to the JTAG connector.  When placing this part you will have to push gently until 

the jack is firmly in place.  Then solder each of the pins.  






 Install the 58-pin Row of Header Pins 

 

This is the only part that is installed on the bottom and soldered on the top (it will be 

inserted into the breadboard).  Place the part so that the long pins extend below the board, 

with the black bumper up against the bottom of the board.  The short pins go through the 

board and are soldered on top.  Watch carefully that you do not use too much solder 

because it may bridge to one of the vias.  When you place the header pins, try to keep all 

of them perpendicularly aligned so that placing the utility board in your breadboard isn‟t 

too much of a headache.  As the header pins come in strips, you will need to use one long 

strip and cut one shorter strip. 

 

Now hopefully you should be done with assembling your board. Before proceeding with 

the lab, you should check all of your solder joints. They should look reliable, filling their 

specific holes in the board. If some of your soldering looks more like a bubble on the top 

of the pin, you probably have a bad connection there.  Also look for solder jumping 

across pins or to vias (solder bridges) and cold solder joints (gray, dull joints).  

 

After you‟ve checked your soldering and verified with a multimeter that there is no 

power to ground short on the board, your board is done! 

 

 Place the Utility Board on the Breadboard 

 

Now you have to place your board on the breadboard. It should fit in the right-most side 

of the breadboard. 


 Test the Power Supply 

 

After you’ve placed the utility board, connect a red wire from the red Vin banana plug 

connector to the upper power row.  Then, from this row, connect a wire to the row of pins 

next to the Vin pin on the utility board.  Then connect a black wire from the GND banana 

plug connector of the breadboard to the second power row (below the red wire).  Connect 
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this row to the Gnd pin of the utility board.  Make sure these wires do not touch each 

other.   

 

Turn on a benchtop power supply and check the 0-6 V scale indicates 5 V.  Adjust it if 

necessary.  Please keep the supply set to 5 V.  However, it is good practice to check the 

supply before connecting it to your board because the knobs occasionally get bumped and 

you don’t want to connect an incorrect voltage that damages your board or causes erratic 

operation. 

 

When the power supply is set correctly, turn it off.  Get a red and a black pair of banana 

plugs and connect the power supply to your breadboard (never connect power circuits 

while the supply is turned on).  Turn the supply back on.  The power LED should turn on.  

Feel your PIC and FPGA and make sure they do not get very warm.  Also check your 

other components, especially the voltage regulators.  The current from the supply should 

be around 100 mA. Check the 3.3 V output pin and confirm that the voltage regulator is 

producing the correct value.  Also check that the capacitors C11 and C12 next to the 1.2 

and 2.5 V regulators have 1.2 and 2.5 V on one of their leads. 

 

 Test the LEDs and switches 

 

You can test your LEDs and switches by connecting a wire in the breadboard between 

one of the switch outputs and one of the LED inputs.  Toggle the switch and check that 

the LED toggles.  Repeat to check all the LEDs and switches.  Remove the wire when 

you are done so that it doesn‟t interfere with subsequent testing of the FPGA.  If anything 

is amiss, turn off the power supply immediately before damaging any parts.  Look for 

solder bridges on your board. 

 

 Test the oscillator 

 

Verify that the oscillator was installed correctly by using the oscilloscope to view the 

oscillator signal.  You should use the analog side of the scope.  The probes are in the 

pouch above the oscilloscope.  Make sure to attach the probe ground wire to your circuit 

ground.  The clock signal is pin 3 of the chip. Adjust the voltage and time scales so you 

can see a nice signal.  Use either the cursors or the Quick Measure feature to verify that 

the correct frequency clock is being produced.   


 Clean Up 

 

Clean up your lab station.  Discard the refuse you accumulated while soldering.  Tin the 

iron and turn it off.  Please try to keep the lab clean and neat as you work because you 

share it with many others. 

 

FPGA Design 
 

Your next goal is to write some Verilog modules to test the hardware on your board and 

operate a 7-segment display.  By writing a module to control the LEDs based on the 
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switches and clock, you will show that these components work and also that the FPGA, 

PROM, and power supply are functional. The system should have the following inputs 

and outputs: 

 

 clk  input  the 40 MHz clock 

s[3:0]  input  the four DIP switches 

led[7:0] output  the 8 lights on the LED bar 

seg[6:0] output  the segments of a common-anode 7-segment display 

 

 

 

 

 

The following tables define the relationship of the LEDs to the switches and clock:  
 

S0 LED0 LED1 

0 OFF ON 

1 ON OFF 
 

S3 S2 LED6 

0 0 OFF 

0 1 OFF 

1 0 OFF 

1 1 ON 
 

 

S1 LED2 LED3 

0 OFF ON 

1 ON OFF 
 

 

 

 

 

 

Table 3 – I/O Requirements 

 

 

 

 

The 7-segment display should display a single hexadecimal digit specified by s[3:0].  

Remember that you will be using a common anode display.  The anode (positive 

terminal) of all of the LEDs is tied to 3.3 V through a single (“common”) pin.  Each 

segment‟s cathode (negative terminal) is connected to a pin.  Therefore, you will need 7 

separate control signals.  Remember that a logic 0 applied to the cathode will turn on the 

segment. The segments are defined as shown below.  Let seg[0] be A and seg[6] be G. 

 

 
Figure 2 – Seven Segment Display layout 

LED7 

 

Blink at ~2.4 Hz 

S2 LED4 LED5 

0 OFF ON 

1 ON OFF 
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Launch the Quartus II software and start the New Project Wizard from the File menu.  

Your first decision is where to keep your files.  Ideally, they would go on your Charlie 

home directory.  However, Quartus can be painfully slow accessing files on the file 

server over the network.  A better choice is to keep your files on the local C drive while 

you are working and then to copy them back to your Charlie account before you log out.  

Please clean up after yourself by deleting the project from the C file when you are done, 

and remember that it is an honor code violation to refer to somebody else‟s code that was 

left on a computer. Note that some CAD tools have trouble with filenames having spaces 

and other special characters, exceeding 8 characters, or in paths not starting with a letter 

drive. The best way to avoid these problems is to choose short alphanumeric filenames. 

 

Create a working directory for the project such as c:\e155\xx\lab1_xx where „xx‟ area 

your initials.  Name the project lab1_xx and click Next. 

 

Click Next at the Add Files page, since we will not be adding any existing files to the 

new project.  Now we will tell Quartus which FPGA we are using.  Under Family, select 

Cyclone III.  Under Available Devices, select EP3C5E144C8.  If you ever forget which 

device to use, the part number is written on the FPGA. 

 

On the next page, select Pick ModelSim-Altera as the Simulation tool and SystemVerilog 

HDL as the format. Click Next and verify the settings for the project.  When you are 

satisfied, click Finish. 

 

Choose File -> New and create a SystemVerilog HDL file.  Save the file as lab1_xx.sv in 

your project directory and check the box to add the file to the current project.  Create 

modules to perform the functions described above.  The 7-segment display decoder 

should be combinational logic. Use a reasonable amount of hierarchy.  Name the top 

level module lab1_xx. The 7-segment display code, for example, will be reused in future 

labs, so it should be a module of its own.  Every module should begin with a comment 

section that includes your name and email address, the date of creation, and a brief 

summary of its purpose, so that somebody else can understand what the module does and 

get ahold of you if they need help.  Comment the modules as appropriate. 

 

Logic Simulation 
 

The next step is to simulate your logic with ModelSim. 

 

Check that Altera has the correct path for ModelSim by invoking Tools → Options. 

Under EDA Tool Options, check that the ModelSim-Altera path is 

 
c:\altera\11.0\modelsim_ae\win32aloem 

 

and set it if necessary. EDA stands for Electronic Design Automation and is the industry 

name for computer-aided design (CAD) tools for electronic design. 
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For unknown reasons, Quartus wants you to compile your code before simulating.  To do 

this, select Processing → Start Compilation to compile your design.  Ignore warnings 

about missing pin assignments or timing violations. 

 

Invoke Modelsim by choosing Tools → Run EDA Simulation Tool → EDA RTL 

Simulation. RTL stands for Register Transfer Level code (your SystemVerilog code).  

The ModelSim window will open.  Get in the habit of watching the transcript window to 

look for errors and to famiarlize yourself with what a good run looks like.  If you see 

errors, close ModelSim, correct your Verilog code in Quartus, and reopen ModelSim. 

 

In ModelSim, simulate your design by choosing Simulate → Start Simulation. Click on 

the + symbol next to the work library and select your code (lab1_xx). 

 

If the wave pane isn‟t open, open it by choosing View → Wave. View all of the inputs 

and outputs of your design by selecting them in the Objects window and dragging them 

to the Waves window. In a more complicated design, you may wish to examine internal 

signals as well. 

 

Manually test your design by forcing the inputs to specific values.  In the transcript 

window, type: 

 
force s 0000 

run 100 

force s 0001 

run 100 

force s 0010 

run 100 

… 

 

You should see the led and seg outputs displaying appropriate values.  Note that the clock 

is not driven and you have not reset any registers so led[7] will be an x.  

 

Check the outputs against your expectations.  If you find any discrepancies, fix the code 

and resumulate.  A helpful shortcut to avoid restarting ModelSim is that you can edit the 

modue by finding it in under “work” in the library pane, right clicking, and choosing 

Edit.  Make your fixes, then right click again and choose Recompile. Then type 

restart -f in the transcript window to restart simulation without having to set up the 

waveforms window again. When you return to Quartus, you‟ll find your corrected code. 

 

Pin Assignment 
 

Next, assign pins to relate the signal names in your Verilog code to physical pin numbers 

on the FPGA.  Launch Assignments → Pin Planner.  A table listing all inputs and outputs 

for the project should appear.  Under Value, type the pin number to associate with the 

given signal.  For example, SW1 is mapped to pin P51, so enter PIN_51 as the value for 

s[0].   
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The FPGA pinouts are shown in the Utility Board Schematic.  Most of the user 

input/output (I/O) pins are tapped out to the headers and labeled on the board silk screen.  

Some have special functions; for example, FPGA pin P43 is connected to LED0 and also 

to the PIC port RD0.  The clock is connected to pin P88 and not to a header pin because a 

40 MHz clock would be degraded by the parasitic capacitance and inductance of the 

breadboard.   

 

The pin numbers for the LEDs and switches are marked on the board‟s silkscreen.  For 

the outputs for the 7-segment display, you may select any I/O pins you‟d like. For 

example, you could use pins 1, 2, 3, 4, 7, 10, and 11, since they are contiguous on the 

board. 

 

Note that the Pin Planner defaults to assuming that each bank of I/O pins receives 2.5 V 

and uses 2.5 V outputs.  However, our system uses a 3.3 V I/O.  Fortunately, leaving the 

voltages at their default value in Pin Planner works and generates 3.3 V outputs. 

 

7-Segment Display Circuit 
 

The 7-segment display will be used throughout the class for general output of numbers. 

In this lab assignment, though, it will be used to output the hexadecimal number entered 

by the user through the DIP switches. 

 

Each segment of the display works as an independent LED. Therefore, the same current-

limiting concern with the LEDs applies to the display as to the on-board bank of LEDs. 

You can limit the current into each segment of the display the same way you did for the 

LEDs on board, adding a suitable resistor to provide roughly 5-20 mA of current.  You 

can find resistors and other such components in the supply cabinet or in the stockroom. 

 

Consult the data sheet for the pinout of the common anode dual seven segment display.  

All seven segments share the same anode, which should be connected to VCC (3.3 V).  

Each of the segments has its own cathode, which can be pulled to 0 to turn on the 

segments. 

 

Be sure to turn power off before wiring circuits on your board. You can choose either 

side of the display to use in this lab. After deciding on which side to use, you will need to 

connect the VDD pin of that side (either VDD1 or VDD2) to 3.3 V. Then connect the input 

pins of the same side of the display to the header pins you chose. Remember to add 

suitable resistor between each of the inputs to the display and the header pins.  These 

LEDs are common anode LEDs.  That is, all the anodes from the LEDs are connected to 

a single VDD (VDD1 or VDD2).  You are driving the cathode of each LED.  Given this 

information, you might need to modify your Verilog file.  Do so in the simplest way 

possible. 

 

Generating the FPGA Configuration Files 
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Now you will synthesize your HDL into a programming file to be transferred onto the 

FPGA.  This outputs an SRAM Object File (.sof) in your project directory that can be 

used to program the FPGA directly over JTAG.  Be sure your SystemVerilog files are 

saved, and choose Processing → Start Compilation.  To help sort the many messages that 

the compilation process generates, click a tab under the Message area to see only that 

type of message.  If compilation is successful but generates warnings, check the Warning 

and Critical Warning tabs for errors relevant to your design.  Warnings about incomplete 

I/O assignments may be ignored if you have in fact assigned all relevant I/O pinsMissing 

Synopsis Design Constraints file warnings and timing analysis violations may also be 

ignored. 

 

Note that Quartus seems to crash from time to time while compiling.  If it does, restart 

and try again. If you find a consistent pattern of what causes the crashes, please let the 

instructor know. 

 

Launch Tools → Netlist Viewers → RTL Viewer and examine the RTL schematic of 

your design.  This shows the logic synthesized from your Verilog design.  Ensure the 

hardware matches your expectations. 

 

Look at the Compilation Report tab.  In the Flow Summary, you should see a total 

number of registers and pins that match your expectations. Under Analysis & Synthesis, 

you can see how the logic blocks and registers are broken down in each module. Under 

Fitter, the Pin-Out File should match the pin assignments you intended. 

 

Programming the FPGA via JTAG 

 
Next, you will load your design onto the FPGA and PROM with an Altera USB Blaster 

programming device and the chip’s JTAG
1
 interface.  Run Tools → Programmer to bring 

up the Programmer window.  In the top left corner, check that USB Blaster is selected 

and use Hardware Setup to choose it if necessary. In the top-right corner, set Mode to 

JTAG.  Your lab1_xx.sof file should appear already in the programmer window, and list 

EP3C5E144 as the associated device.  If it does not appear, click the Add File… button 

and find the file by hand in your project directory.  Be sure the Program/Configure box 

for your .sof file is checked. 
 

You are now ready to program the FPGA.  Connect the USB Blaster to the JTAG port 

with the ribbon cable leading off to the right of the board.  Turn on the power supply.  In 

the programmer window, press Start to begin the process.  Check the Messages pane for 

programmer output, and verify that there were no errors.  Look for “Configuration 

succeeded” and “Successfully performed operation(s)” messages.   

 

                                                           
1 JTAG stands for the Joint Test Access Group.  The JTAG interface is a serial interface used to 

communicate with chips on a board using a few pins during testing and configuration.  JTAG is also called 

Boundary Scan. 
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At this point, with your design loaded, you should see the hexadecimal digit currently set 

on the switches displayed on the 7-segment display.  Debug your design until it is fully 

functional.  Good luck! 

 

If you have problems, the following checklist may help: 

 

1. Check the voltage outputs on each of the voltage regulators. Also check it on the 

adjacent capacitors (C10-12) to detect a bad connection between the regulator output 

and the PCB.  This is one of the most common soldering problems. 

2. Check that the power supply is hooked up correctly.  Measure with the volt meter that 

you have 5 volts between the Vin and GND pins on your FPGA board.  Check that the 

current out of the power supply is less than 200 mA.  If the current is high, look for 

power/ground shorts on your board.  Otherwise, if the voltage is incorrect, adjust the 

power supply to produce the correct output.   

3. If the JTAG programmer indicates “Program Failed,” first, make sure your board is 

powered, close the Programmer window and try again.  Sometimes programming 

fails if you power on your board after you open the Programmer window.  If 

programming still fails the problem could be in your board or in the programmer.  If 

programming works on a classmate‟s board using the same programmer, you may 

have a bad solder joint or other board error.  If the programmer doesn‟t work on 

multiple boards, please report it to the instructor.   

4. If your power is good but the FPGA still refuses to respond, check the NCONFIG 

signal (on the FPGA_RESET button).  It should be 1 when the button is not pressed. 

5. If the LEDs flicker on and off when you tap on the board or toggle switches, you 

probably have a loose connection or marginal solder joint somewhere.  Two common 

problems in the past are poor banana plugs that are too small for the recepticals and 

inadequate solder joints on the voltage regulators. 

6. If the LEDs do something but do not function correctly, the problem is likely in your 

Quartus schematics or implementation.  Check the implementation report file that the 

pin mapping is what you want.  Check for any logic bugs. 

7. When exiting the programmer window, don‟t save anything.  That way the design 

programmed to the PROM or FPGA is always the most recent build. 

 

Programming the PROM with the Serial Flash Loader 
 

Programming over JTAG only changes the volatile SRAM of the FPGA itself and does 

not write to the non-volatile PROM.  The design will only stay on the FPGA until it is 

reset or power is disconnected (try it!).  Programming the PROM directly would require 

adding an additional programmer port to the board, connected to the Active Serial (AS) 

interface between the PROM and the FPGA.  Instead, it can be programmed over JTAG 

through the FPGA, using the Serial Flash Loader function in Quartus.  JTAG is used to 

write a temporary design to the FPGA that effectively bridges the JTAG and AS 

interfaces, allowing the USB Blaster to talk to the PROM without being physically 

connected to it. 
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Figure 3 – Serial Flash Loader block diagram.  A program bridges the JTAG and  

Active Serial interfaces to let the USB Blaster talk to the PROM. 

 

When debugging your design, simple JTAG programming has advantages, namely that it 

is a much faster process.  Losing the contents of the FPGA with every reset is less 

important if your design is being changed with every test.  The Serial Flash Loader is 

much slower than JTAG programming and requires extra steps to complete, but should be 

used whenever the design is unlikely to be changed in the short term. 

 

Always write your finished labs to the PROM before checkoff.  Also remember that 

whatever design you last programmed to the PROM will be loaded immediately when the 

FPGA turns on.  Forgetting this could cause you massive confusion when debugging, 

especially in Labs 4-7 when old code on the FPGA might interfere with pins you are 

trying to use on your PIC. 

 

To set up the Serial Flash Loader, run Tools → MegaWizard Plugin Manager.  Choose  

„Create a new custom megafunction variation‟ and press Next.  At the next dialog, 

expand the JTAG Accessible Extensions folder and select Serial Flash Loader from the 

options below it.  In the output file name box, append „sfl‟ to the path already there.  

Click through the rest of the wizard with the default options, and click Yes to add the file 

to your design. 

 

The MegaWizard step need only be done once per Quartus project.  The subsequent steps 

must be completed each time you program the PROM. 

 

Compile your project to generate an up-to-date .sof file.  Next, you will convert the .sof 

to a JTAG Indirect Configuration (.jic) file for use with the Serial Flash Loader.  Choose 

File → Convert Programming Files.  Set the programming file type to JTAG Indirect 

Configuration File and the configuration device to EPCS4.  Pick a simple file name, such 

as lab1_xx.jic.   

 

Under Input Files to Convert, select SOF Data and click Add File.  Find your lab1_xx.sof 

and press OK.  Now highlight Flash Loader and click Add Device.  Select Cyclone III in 

the left pane, then EP3C5 in the right pane, and click OK.  Click Generate and verify the 

.jic was generated successfully, then close the window. 
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Launch the Programmer and remove your old lab1_xx.sof from the programming file list.  

Now add the lab1_xx.jic file you just generated.  Check both Program / Configure boxes 

and click Start.  Watch the Messages pane for any errors.  When the process completes, 

your design is loaded on the PROM.  It will automatically be loaded onto the FPGA after 

reset or power-on until the Serial Flash Loader is used again to replace it. 

 

If you want to erase the EPROM, change the EPCS4 option from Program/Configure to 

Erase and click Start again.   

 

When you are finished, save you files somewhere (such as your network drive or a USB 

key) and remove the files from the local machine. Good luck!  

 

You will test the PIC microcontroller in Lab 4 and the video output in Lab 7. 

 

What to Turn In 
 

Turn in a lab report with the following sections: 

 

 Introduction: Briefly explain what was done. 

 Design and Testing Methodology:  Explain how you approached the design 

of this assignment from both a software and a hardware standpoint (as 

appropriate).  Include how you tested your design. These test should convince 

the reader that the requirements of the assignment have been met. 

 Technical Documentation: Include your Verilog code and schematics of 

your circuits. 

 Quality and clarity of your code is import.  Make sure it is well 

commented. 

 Schematics of your breadboarded circuits should be sufficient for another 

engineer to understand and reconstruct the circuit on the breadboard.  

Always use standard symbols for standard components such as resistors, 

switches, transistors, diodes, etc.  The reader shouldn‟t have to open 

Quartus to relate your Verilog code to the schematic.  Don‟t assume that 

the reader has memorized the pinouts of any chips.  There is no need to 

draw any of the circuitry on the board; just refer to it by the pins number 

and name. 

 Results and Discussion: Did you accomplish all of the prescribed tasks? If 

not, what are the shortcomings? How might you address them given more 

time? As appropriate, how did the design perform (ex. How 

fast/accurate/reliable was it?).  Is there anything you would do differently if 

you were to redo the lab?  Is there anything else interesting worth mentioning? 

 Conclusions: Briefly summarize what was done and how it performed.  

 How many hours did you spend on the lab?  Any comments, suggestions, 

or complaints about the assignment? This will not count toward your 

grade, but will help refine the lab for the future. 
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The report does not need to be long, but should be complete. Some individual questions 

may not apply to this particular lab, but are listed to give you a general idea of what is 

desired. Future reports will follow a similar format and the questions may be more 

applicable in these instances. 

 

Have your lab checked off by the instructor.  You will need to demonstrate that the board 

and 7-segment display operate correctly.  You will also be asked a question about some 

part of the lab or your board.  You should be thoroughly familiar with all of the lab and 

the components of your board to be able to answer the question.  The oral exam is 

typically in the form of a “Fault-Tolerance Question.”  What would happen if a particular 

wire is broken or a pin is shorted to VCC or GND?  Be prepared for any other questions 

about your lab, however. 
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Appendix: FPGA Initialization Sequence 
 

If your FPGA board is assembled incorrectly or your PROM is programmed wrong, you may find that your 

FPGA fails to initialize.  This sheet documents the initialization process to help you track down your 

problem.  The initialization sequence is described in more detail in pages 9-9 through 9-14 of the Cyclone 3 

Device Handbook (vol. 1).   

 

The MSEL[2:0] pins on the FPGA are  used to select a configuration scheme.  They are connected to GND, 

VCC and GND respectively to indicate Active Serial configuration at 3.3V levels. 

 

When the FPGA powers on or you release the reset switch (pulling nCONFIG from low to high), the device 

begins initialization, pulling nSTATUS and CONF_DONE low while clearing internal memory and 

preparing for configuration. In < 200ms, nSTATUS is then pulled high to indicate the start of 

configuration. 

 

During configuration, the FPGA generates a 30 MHz clock via an internal oscillator and transmits the 

signal via DCLK to the EPCS4 PROM.  The PROM responds by sending serial configuration data back 

over the DATA connection.  The FPGA has 3,000,000 bits of internal state, so serial configuration via 

PROM should complete in about 100ms.  When configuration is complete, CONF_DONE is pulled high 

again, and the device enters user mode < 0.5ms later.  If CONF_DONE is never asserted or nSTATUS is 

pulled low after initialization completes, a configuration error has occurred.  Check the soldering on the 

FPGA and PROM. 

 

The configuration waveforms are shown below: 
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